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第1章 インストール – Installation –

OpTaliX は専用のインストール・プログラムを使ってインストールします。インストール・

プログラムは、そのコンピュータにOpTaliX の旧バージョンがインストールされているか

どうかを判別したうえでユーザから要求があれば、それをバックアップします。インストー

ルは基本的には次の順序で行います。

• OpTaliX の CD-ROMディスクを CD-ROMトレーに入れます。

• エクスプローラを開いて、CD-ROMドライブを選択します。

• “optalix pro setup.exe ” ファイルをダブルクリックします。

• インストールが開始されますので、画面の指示に従って作業を進めます。

ステップを追った詳しい説明は、製品に添付されている “別途インストールの手引き” を

ご覧ください。

1.1 動作条件：オペレーティング・システム (Software Requirements)

OpTaliX を使用するには、32bitのマイクロソフトWindowsが必要です。Windows 98/

Me /NTでも動作することがありますが、OpTaliX には適しません。Windows 2000/ XPを

推奨します。

1.2 動作条件：ハードウェア (Hardware Requirements)

最小構成: 推奨構成:

CPU: Pentium 100MHz CPU: Pentium 4　 1GHz以上

RAM: 128MB RAM: 256MB

ハードディスク空き容量: 60MB ハードディスク空き容量: 80MB

モニタ: 800× 600ピクセル モニタ: 1024× 768ピクセル
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このページは白紙です。
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第2章 OpTaliX の開始と終了 – Starting and
Exiting OpTaliX –

OpTaliX はマイクロソフトのウインドウズ上でのみ起動できます。起動をするにはプログ

ラム・グループの OpTaliX メニューをクリックするか、デスクトップ上のOpTaliX のア

イコンをダブルクリックしてください。あるいはデスクトップおよびウインドウズのエクス

プローラ上のOpTaliX のレンズデータをダブルクリックすることで起動する方法もありま

す。さらに DOSウィンドウの DOSプロンプトから起動することも可能です。

2.1 プログラム・グループからの起動

(Starting OpTaliX from the Program Group)

OpTaliX をWindows 98/Me/NT/2000/XPから起動するには、スタートボタンをクリック

し、プログラムボタンをクリックします。次に OpTaliX のプログラム・グループをクリッ

クし、最後に 2.1図に示す OpTaliX メニューグループから、望みのOpTaliX (OpTaliX-Pro

または OpTaliX-LT等)をクリックします。

図 2.1: OpTaliX のプログラム・グループのメニュー

OpTaliX のプログラム・グループには、OpTaliX のプログラム本体に加え、HTML 形

式のヘルプ、リファレンズマニュアル、チュートリアル、OpTaliX のアンインストール・

プログラムが含まれます。
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2.2 ウインドウズ・エクスプローラからの起動

(Starting OpTaliX from Windows Explorer)

OpTaliX のレンズデータに付けられる拡張子 (.otx)は、OpTaliX がインストールされ

た時点でウインドウズに登録されています。このため、任意の OpTaliX レンズデータファ

イルのアイコンをダブルクリックすれば、OpTaliX プログラムそのものが起動されるとと

もに、レンズデータファイルの内容が自動的に読み込まれます。

2.3 DOSウインドウからの起動

(Starting OpTaliX from a DOS Window)

ウインドウズ上でスタート→プログラム→アクセサリとたどり、DOSプロンプトのメ

ニューアイテムをクリックし、DOSウインドウを起動してください。DOSウインドウのDOS

プロンプトから OpTaliX を起動するには、キーボードから次の手順で入力してください。

c:

cd program files

cd optalix-pro または cd optalix-lt

　 optalixp または optalix lt

もしもOpTaliX がインストールされているフォルダがc:Y=program filesY=optalix-pro

または c:Y=program filesY=optalix-lt でない場合には、OpTaliX がインストール

されているフォルダに移動してから、OpTaliX を起動してください。なお、“optalixp

mylens.otx ” の要領で、任意の OpTaliX プログラム名に続いてOpTaliX のデータファ

イル名を記述することも可能です。この場合には、ここで指定したデータファイルが起動と

ともに読み込まれます。もしデータファイル名を省略した場合には、もっとも直近に使用し

たレンズデータと共に起動します。

2.4 OpTaliX の終了 (Exiting from OpTaliX )

• OpTaliX のメインメニューにある FILEから Exitをクリックをするか、OpTaliX

のメインウインドウの右上にあるクローズボタン をクリックすればOpTaliX は終

了します。

• メインウインドウが選択された状態で、ESCキーを押下すれば、OpTaliX は終了し

ます。

• コマンドラインから、EXI または QUIT とタイプし、エンターキーを押下すれば、

OpTaliX は終了します。

通常、OpTaliX を終了しようとすると、本当に終了するかどうかを確認するためのウイ

ンドウが現れます。このウインドウを経由することなく直ちに OpTaliX を終了するには、

OpTaliX Tutorial
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コマンドラインまたはマクロから

EXI Y

あるいは

EXI Yes

を実行してください。

Tutorial OpTaliX
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　このページは白紙です。
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第3章 基本操作 – First Steps –

次のアイコンをクリックすれば、OpTaliX を起動できます。

OpTaliX-Proを起動するためのアイコンです。

OpTaliX を起動した後、メインウインドウの他に２つのウインドウが開きます。そのう

ちのひとつは、テキストウインドウです。もうひとつは履歴ウインドウです。これらが開い

ている状態を図 3.1に示します。

OpTaliX はコマンドおよびマクロを使ってコマンドラインインターフェースから操作で

きますし、あるいはメニューやボタンをクリックするグラフィカル・ユーザ・インターフェー

ス (GUI)から操作することもできます。これらは境界なくシームレスに統合されていますの

で、マウスを使ったクリックによる操作とコマンドラインから個別のコマンドを入力する方

法のどちらでも必要に応じていつでも使用できます。コマンドのほとんどすべてについて、

それと同じ機能を持ったメニュー項目があり、マウスでクリックするだけで利用できます。

これらは、メインウインドの上部のメニューからたどれます。

������
�����

�������

	
��
�
�����

�������

図 3.1: OpTaliX を起動した直後のメインウインドウ。ただし、ウインドウのサイズと位置

は状況により異なることがあります。
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画面の 2ヶ所 (ツールバーの下とテキストウインドウの下部)にコマンド入力用のコマンド

ラインがあります。どちらのコマンドラインも同様に使えます。

ここには OpTaliX のすべてのコマンドを入力できます。OpTaliX のコマンドはあまり

に多いので、本書ではそのうちのいくつかについて紹介することしかできません。しかし、

リファレンスマニュアルにはすべてのコマンドに関する詳しい説明があります。

コマンドの書式はプログラム操作、最適化に関する定義、マクロ言語のいずれにおいても

共通です。メニューが選択された場合には、それ対応したコマンドが内部的に生成され、実

行されます。

図 3.1に示すテキストウインドウおよび履歴ウインドウの機能は下記のとおりです。

テキストウインドウ

(Text Window)
テキスト・ウインドウには、数値解析結果の全てが表示されま

す。また設計 (最適化)のプロセスで必要となる各種の情報が

表示されます。

履歴ウインドウ

(History Window)
履歴ウインドウは、その名前が示すとおり、コマンドライン

からユーザが入力したか、あるいは GUIによる操作に伴って

OpTaliX が自動的に生成したコマンドのすべての履歴が順

次、表示されます。

これら 2つのウインドウ、つまりテキストウインドウと履歴ウインドウは常に表示され、

閉じることはできません。

一度プログラムが立ち上がるとデフォルトの光学系、つまり前回終了時のOpTaliX のレ

ンズデータが読み込まれます。同様にOpTaliX の終了時には、その時点のレンズデータが

デフォルトの光学系として自動的に保存されます。この機能により、設計や解析を断続的に

行った場合でも実質的には OpTaliX の環境はそのまま維持されます。

3.1 メインウインドウ (Main Window)

OpTaliX のメインウインドウは、メニューバー、ツールバーそしてコマンドラインを備

えています。

図 3.2:メインウインドウ: メニューバー/ツールバー/コマンドライン

OpTaliX Tutorial
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3.1.1 メニューバー (Menu Bar)

図 3.2に示すメニューバーは、OpTaliX メニューの最上位のアイテムを示しています。こ

こに表示された各メニューをクリックすると、プルダウン形式でサブメニューとそのオプ

ションが表示されます。メニューがグレーで表示されている場合は、その時点で選択できな

い状態にあることを示しています。

File ファイルの呼出し/保存。CodeV/ Zemax等とのファイル変換。

OpTaliX 自身の設定。さらにレンズデータファイルの履歴リ

ストもあります。このリストにはその時点で読み込まれている

レンズデータも表示されます。ここに記載されたファイル名を

クリックすると、その内容が即座に読み込まれます。

List 各種リストの出力。レンズデータ、ガラス、コーティング、最

適化に関するデータ等

Edit 各種データの編集。面データ、システムデータ、ズームデータ、

ツェルニケデータ等

Display 各種データの表示。レンズ断面図、グローバル座標等

Geom.Analysis 幾何光学解析。光線ファン (縦収差図、横収差図等)、スポット

ダイアグラム歪曲、3次収差、偏光、透過率等

Diffr.Analysis 波動光学解析 MTF、PSF、波面収差、干渉縞、結合効率等

Tools 高度な、あるいは特殊、便利な設定等。たとえば、最良像面位

置を自動的に設定するオートフォーカス、ガラスコード (MIL

コード)で表記されたの仮想ガラスを実存する直近のガラスに

置き換える機能、簡単なレンズ系や望遠鏡データを解析的な設

定、ユーザ定義グラフィクス、マクロ等

Optimization 最適化のための変数やメリット関数 (目標関数、制約関数)の

設定と実行

Glass Manager 登録済みの光学材料の特性の表示。たとえば、屈折率-アッベ

数のマップ、部分分散図など。また、溶解ガラス (つまりユー

ザ定義ガラス)の設定もここで行えます。

Coatings 光学薄膜の編集、最適化および特性の評価と表示 (反射率、透

過率、位相など)

Manufacturing 光学系の製造支援のための諸機能。公差解析、ニュートン原器

のフィッティング、非球面デフォメーションの計算表示など、

Help ヘルプ機能の起動

Tutorial OpTaliX
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3.1.2 キーボード・ショートカット (Keyboard Shortcuts (Accelerators))

OpTaliX の機能の一部は、マウスによるメニューバーからの選択だけでなく、キーボー

ドからのショートカットによっても選択できます。たとえば、Ctrl+Sは、マウスによるメ

ニューの選択をすることなく、レンズデータを直ちにファイルに保存 (Save)できます。ここ

で Ctrl+Sとは、“Ctrl” キーを押したままで “S” キーを押す操作のことです。ただし、ショー

トカットはコマンドラインや、ダイアログボックス中のフィールドにカーソルが点滅してい

る状態では機能しません。ショートカットと各機能の対応は、OpTaliX の各メニューに併

記されていますので参照してください（参照の際にはマウスでメニューをクリックしてくだ

さい）。

3.1.3 ツールバー (Tool Bar)

ツールバーを用いると、頻繁に使用する機能を簡単に実行できます。アイコンの上にマウ

スを移動すると、説明が表示されます。

新規レンズデータの作成。その時点のデータはクリアされます。

レンズデータをファイルから読み込み

レンズデータをファイルに保存

画角、波長、Fno.など、システムデータの編集

曲率半径や面間隔など、面データを編集するエディタを起動

システムデータ、面データ、近軸量のリストを作成

レンズ断面図の描画 (YZ平面)

光学系の 3次元ソリッド図描画ソフト “POV-Ray”を起動

横収差図の描画

スポットダイアグラムの描画

点像強度分布 (PSF)の評価

点像強度分布 (PSF)の濃淡画像描画

波動光学的 MTF計算の画角依存性を図示。もし視野点の指定が 1カ所だけならば、

MTFの空間周波数依存性を描画

最適化の変数およびメリット関数 (目標関数、制約条件)を編集

最適化を実行

選択された波長と視野点に対する最良像面位置を探査、設定

ズーム/多重構成データを編集

OpTaliX Tutorial
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公差設定を編集

物理光学的ビーム伝播パラメータを編集

描画用光線の光路を計算しプロット

各面の光線有効径を、光学系 (全系)の開口径とビネッティングを考慮するように指定

された面 (固定アパーチャが指定された面)のアパーチャ設定値より評価

コーティング (光学多層薄膜)を編集

コーティングの反射率を評価

コーティングの透過率を

ヘルプ

3.1.4 コマンドライン (Command Line)

OpTaliX は、メニューを使わなくともすべての操作をコマンドだけで処理できます。ツー

ルバーのすぐ下と、テキストウインドウの下部にはコマンドを入力するためのスペースがあ

ります。これをコマンドラインといいます。(図 3.4および図 3.3を参照)。どちらのコマンド

ラインも全く同一の機能をもっています。コマンドに関する説明はマニュアルまたはオンラ

インヘルプを参照してください。履歴ウインドウも役に立ちます。ここには、それまでに入

力したコマンドの履歴が表示されます。メニューからの実行の履歴もそれに対応したコマ

ンドに変換されここに出力されます。履歴ウインドウを使えば、メニューとコマンドの対応

を学ぶこともできます。

図 3.3:メニュー下のコマンドライン (複数のコマンドをセミコロンで区切って一行に記述し

ています)

コマンドラインを含むウインドウがアクティブになった状態でテキストを入力するだけで

OpTaliX はそれをコマンドラインへの入力として認識します。しかし、もし認識されない

場合はコマンドラインにマウスを移動し、そこでクリックすれば確実に認識されます。

コマンドの入力は、CodeVに類似の自由書式で行います。コマンドのパラメータはスペー

スを一つ以上空けて記述します。複数のスペースは一つのスペースとして扱われます。疑問

符 “?を付けると、パラメータを入力したり編集したりできるダイアログボックスが起動し

ます。“?” はほとんどのすべてのコマンドに適用できます。

Tutorial OpTaliX



12 基本操作

コマンドのパラメータは数値をそのまま入力するほか、THI s3 sqrt(2)+1 のように

数式を指定することも可能です。複数のコマンドをセミコロン “;” で区切って 1行に記述で

きます。１行の長さは最大 256文字です

多くのコマンドのパラメータに、面/画角/波長/ズーム/光線等を指定できます。それら

は次のとおりです。

si..j 面範囲 (面番号 iから jまで)

fi..j 画角範囲 (画角番号 iから jまで)

wi..j 波長範囲 (波長番号 iから jまで)

ri..j 光線範囲 (光線番号 iから jまで)

zi..j ズームポジション範囲 (ズーム番号 iから jまで)

ci..j 係数範囲 (係数番号 iから jまで)

pi..j 瞳 (アパーチャ)範囲 (面番号 iから jまで)

例えば、“s3..4 ” は第 3面から第 4面を示します。引数が無い場合には、デフォルト値

が適用されるか、コマンドによってはダイアログボックスが起動して必要なデータの入力が

促されます。例えばスポットダイアグラムの場合には、システム構成データとして設定され

ている画角と波長がデフォルト値として用いられます。下記の例は、コマンド入力の入力書

式の例です。“!” の後ろの記述は説明文です。コマンドではありません。

rdy s1..3 10.0 ! 第 1から 3面までの Y方向 (YZ面内)の曲率半径を 10.0に設定

yan f4 2.5 ! 4面の画角 (半角)を 2.5◦に設定
psf f1 ! 第 1画角の PSFを計算

3.1.5 ステータスバー (Status Bar)

ステータスバーはメインウインドウの下部にあり、下記内容を表示しています。

図 3.4:テキストウインドウ下のコマンドライン (パラメータに演算式を使用しています)

OpTaliX Tutorial
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Grid 像解析に用いる光線グリッドの分割数を表示しています。光線グリッドは入射瞳面を
N×Nのグリッドに分割します。像解析の際、そのグリッド 1つにつき、1本の光線が

追跡されます。Nの値を大きくすれば像評価の度は向上しますが、計算時間はそれ以

上に増加します。Nの値は、通常は 32または 64程度が推奨されます。光線グリッド

は、“EDI CNF” コマンドまたはメニューの Edit→ Configurationとたどることで設定

できます。

OUT テキストと数値結果の出力先を表示しています。

GRA グラフの出力先を表示しています。

POS 現在選択されているズーム/多重構成ポジションを表示します。OpTaliX はこのポジ

ションについて像評価を行います。最適化の際に選択されるポジションとは関係あり

ません。

Path その時点で読み込まれているファイルの名前をパス名を含めて表示しています。

3.2 グラフィックウインドウ (Graphics window)

各図表に対してそれぞれ独立に別個のウインドウが開きます。サイズと位置を自由に調整

できます。

図 3.5:グラフィックウインドウ

3.2.1 ツールバー (Toolbar)

グラフィックウインドウのそれぞれにツールバーが用意されていて、印刷、描画設定、図

の拡大とその解除、図のファイルへの出力、再描画などの処理が行えます。各アイコンの意

味は次のとおりです。
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14 基本操作

作図スケール、収差のスケールなど、描画設定の変更を行うためのアイコンです。こ

こをクリックすると、専用のダイアログボックスが開きます。

図をデフォルトのプリンタから印刷します

部分拡大されていた図を元の倍率に戻します。
図の更新機能です。レンズデータを変更した場合などに使います。なお、グラフィッ

クウインドウのどこであってもダブルクリックをすると、図は即座に更新されます。

詳細は 3.2.3章を参照してください。

グラフィックウインドウに表示されている内容はファイルにエクスポートできます。

図をクリップボードにコピー　 3.3章も参照してください。

WMFフォーマットでファイルに出力。

CGMフォーマットでファイルに出力。

PNGフォーマットでファイルに出力。

SVGフォーマットでファイルに出力。

PCXフォーマットでファイルに出力。

BMPフォーマットでファイルに出力。

HPGフォーマットでファイルに出力。

DXFフォーマットでファイルに出力。

EPSフォーマットでファイルに出力。

3.2.2 ウインドウの拡大と縮小 (Zoom)

グラフウインドウ全体は、その縁をクリックしてドラッグするとサイズを変更できます。

表示されている図の部分拡大をするには、拡大したい範囲 (四角形)の片方の角をクリック

し、そのまま対角方向にドラッグして離します。(図 3.6を参照)

3.2.3 表示されている図の更新 (Graphics Update)

多くのグラフィクスウインドウは必要に応じて自動的に更新されるので、通常はユーザが

操作する必要はありません。しかし更新のための計算負荷が大きな評価 (MTFや PSFなど)

については、ユーザの指定がない限り更新されません。そうでないとOpTaliX の反応速度

が不必要に低下するためです。
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図 3.6:図の部分拡大。拡大したい範囲 (四角形)の片方の角をクリックし、そのまま対角方

向にドラッグして離します。図中の赤枠が拡大されます。

表示されている図の更新をするには、グラフィクスウインドウの左端にあるアイコン

をクリックするか、あるいはグラフウインドウ内の任意の場所でダブルクリックします。

3.3 クリップボードのサポート (Clipboard Support)

表示されているテキストをWindowsのクリップボードにコピーできます。テキストウイ

ンドウと履歴ウインドウのどちらからでもコピー可能です。コピーする範囲をドラッグによ

り選択して、Ctrl-C キーを押すか、あるいはウインドウの上部にある、 アイコンをク

リックしてください。

描画されている図をWindowsのクリップボードにコピーできます。図を表示しているウ

インドウの左上にある アイコンをクリックしてください。

3.4 面エディタ (The Surface Editor)

面エディタは、パラメータの種類毎に分類されたタブ付のダイアログボックスです。面エ

ディタはメニューから Edit→ Surface Dataを選択するか、アイコン をクリックするか、

あるいはコマンド “EDI SUR” を入力すると開きます。面パラメータは数枚のシートに分か

れていて、それぞれにタブが付いています。(図 3.7参照)。

図 3.7に示されたのタブをクリックすると、それぞれ次のデータを編集するためのシート

が現れます。

Standard Data このシートからは最も頻繁に使用する一般的な面データ、つまり曲

率半径、面間隔、材料、アパーチャ、面タイプ等を編集できます。
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16 基本操作

図 3.7:面エディタ。パラメータの種類ごとにタブによって分類されています。

Decenter, Tilts シフトおよびティルトに関わるすべてのデータがこのシートに記

載されなくてはなりません。ここに直接設定することもできます

し、コマンドラインから、コマンドによって設定することもできま

す。ここで設定したパラメータを光学評価や設計に反映するには、

Standard Data タブの Type 欄に “D” を追加しなくてはなりま

せん。

Asphere 軸対称非球面の係数とトロイダル面に関する情報をここで設定しま

す。ここで設定したパラメータを光学評価や設計に反映するには、

Standard Data タブの Type 欄に記述された “S” (Sphere:球面の

意)を “A”(Asphere:非球面の意)に変更しなくてはなりません。　

GRIN 屈折率分布型 (GRIN)のレンズおよび面に関する情報を設定します。

具体的には屈折率分布係数および、屈折率分布の偏芯に関する情報

ですここで設定したパラメータを光学評価や設計に反映するには、

Standard Data タブの Type 欄に “I” を追加しなくてはなりませ

ん。

Solves このシートを使えば、各面を通過する近軸光線の特性を直接制御で

きます。たとえば、面への光線入射角、射出傾角または近軸光線高、

アプラナティック条件などです。指定した近軸条件が満足されるよ

うに面の曲率半径や面間隔が自動的に調整されます。これらの機能

は “ソルブ” と呼ばれます。
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3.4面エディタ 17

Special Apertures 特殊形状アパーチャ形状、つまり、円形、矩形、楕円以外のすべて

の形状をここで定義します。複数のアパーチャ形状の論理和や論理

積により複雑なアパーチャ形状を定義する場合も、ここで指定しま

す。

Hologram ホログラフィック (回折素子)やグレーティングに関する情報は、こ

こで設定します。設定したパラメータを光学評価や設計に反映する

には、Standard Data タブの Type 欄に “H” または “G” を追加

しなくてはなりません。

Misc その他、種々の面データを指定するシートです。

ダイアログの下端にはズームポジションを選択したり、自動的に近軸像面位置 (PIM)を設

定するか否かを指定するチェックボックス、カーソル位置への面の挿入削除のためのボタン

があります。スプレッドシート内の移動および選択は、マウスまたはキーボードで操作しま

す。とりわけマウスによる操作が簡単です。

• シート中のセルをクリックすれば、そのセルが選択されます。

• 行または列のタイトル欄をクリックすれば、その行または列すべてを選択できます。

• スクロールバーをドラッグするとシートがスクロールします。

• 入力値は、[Enter] キーが押された時またはカーソルが別のセルに移動したときに始
めて確定します。入力したままの状態では、たとえ画面表示が変わっていたとしても、

まだ確定していません。

面エディタは、コンピュータのリソースメモリを大量に使用します。そのためWindows98/Me

では問題を生じることがあります。これは OpTaliX 固有の問題ではなく、Windows98/Me

の内部構造に由来するもので、とりわけ複数のプログラムを同時に開いているとき発生しが

ちです。面エディタが期待どおりに動作しない場合は、OpTaliX 以外のプログラムを極力、

閉じてください。なお、Windows NT/ 2000/ XPでは、そのような問題は (十分な物理メモリ

を搭載している限り)生じません。

これ以降はタブによって特徴付けられた各スプレッドシートの内容を、やや詳しく説明し

ます。

3.4.1 一般的な面データ (Standard Data)

“Standard Data”(一般データ)タブには、頻繁に使用されるデータ (曲率半径、面間隔、材

料、アパーチャ等)が収められています。データ欄の右側の欄 (タイトル欄に点 “・” で示さ
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18 基本操作

れている欄)は各データを自動設計の変数に指定する場合や、面データ間のピックアップ (従

属関係)を設定する際に使用します。この欄に入力できる項目は下記のとおりです。

v 最適化の変数に指定 (シングルポジション)

z 最適化のズーム変数に指定

整数 ピックアップ面番号 (負の符号で向きを反転)

s ソルブの表示 (ソルブ機能は “Solve” タブで設定)

各欄のタイトルは以下の内容を意味しています。

Type 面タイプを指定します。4種類までの組合わせ記述が可能です。面タイプには、表

3.4に記されているとおり、必須タイプと選択タイプがあります。

Radius 曲率半径を指定します。曲率中心が面の右側にある場合は曲率半径の符号は正で

す。曲率中心が面の左側にある場合はその符号は負です。面の凹凸と符号が対応して

いるわけではありませんから、注意してください。なお平面を定義する場合には便宜

的にゼロを設定すれば、OpTaliX の内部で、曲率半径無限大と読み替えられます。

この便法は、面が非球面である場合の頂点曲率半径が平面である場合も同様です。

Distance 面間隔を指定します。連続する 2つの面の間隔を光軸に沿って計ります。面間

隔を指定する面 (現在の面)に続く面 (後続面)が現在の面の右側にあるとき、面間隔

の符号は正です。その逆に後続面が現在の面の左側にあるとき、面間隔の符号は負で

す。ただしミラーで反射した後の面間隔は、このルールは逆転します。さらにミラー

で反射すると、再びルールは逆転して通常どおりの符号にもどり、以下同様に繰り返

します。

Glass 材質名を指定します。あらかじめ OpTaliX のデータベースに登録された材料 (ガ

ラス、プラスチック、液晶など)を指定できます。または溶解ガラス (ユーザが屈折率

を登録した光学材料)も指定できます。溶解ガラスの詳細はリファレンスマニュアルを

参照してください。

APE-Y 各面のアパーチャ半径を指定します。

* この欄には 0または 1のいずれかだけを指定できます。1を指定すると APE-Yに設定し
た径がこの面に許される最大有効径となり、これを越えた光線はこの面を通過できな

くなります。この欄に 1を指定したアパーチャを、“固定アパーチャ” といいます。一

方、この欄に 0を指定した場合には、この面で光線有効径の規制は生じません。ただ

し、絞り面 (STOP面)だけは、0/1の指定の如何に関わらず、常に光線規制が行われ

ます。

Shape アパーチャ形状を指定します。円形アパーチャ、楕円アパーチャ、矩形アパーチャ

から選べます。

Glb 面座標がグローバルな参照によって定義されることを指定します。通常、各面のロー

カルな座標系はそれに隣接して先行する面の座標系によって規定されます。しかし、

グローバルな参照を宣言すれば、任意の先行面の座標系によって規定できます。この

欄には参照すべき面の番号を入力します。ただし先行する面に限ります。
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Comment 面につけるコメントです。

Coating コーティングのデータを、ファイル名 (最大 8文字)を指定することにより貼り付

けます。

必須の面タイプ 任意の面タイプ

S 球面 D 平行偏芯および/あるいはティルトし

た面

A 非球面 M 鏡面

L レンズモジュール (理想レンズ) G グレーティング面 ,回折格子面

X “光線追跡しない” 面。面の座標を変換

する目的でのみ使われる面。光線追跡

は行われません。

H ホログラフィック面

F フレネル面

I 屈折率分布

N ノンシーケンシャル面。面タイプ “D”

と組合わせて使用されなければなりま

せん。

P ライトパイプまたはステップインデッ

クスファイバ。パイプ/ファイバのテー

パ角は最終面のアパーチャ半径によっ

て定義されます.

R 同一面形状の組み合わせからなるレン

ズアレイ

T 全反射 (TIR)面

U ユーザ定義面

Z ツェルニケ面

C 回転対称スプライン面のデフォメーシ

ョン

W 格子データで与えられた 2次元面のデ

フォメーション

E 対称性のない一般の自由曲面を 2次元

スプライン面で表現します。この機能

は準備中であり、まだ使えません。

表 3.4:面タイプの一覧表。例えば偏芯した球面ミラーであれば、“SDM” と指定。
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3.4.2 面の偏芯 (シフトおよびティルト)　 (Decenter, Tilts)

シフトおよびティルトに関する設定は、すべてこのシートから行います。タイトル欄に

XDE、YDE、ZDE、ADE、BDE、CDEと記された欄の右側に点 “・” で示されている欄があ

ります。この欄を使って次の設定を行えます。

v 最適化の変数に設定 (シングルポジション)されます。

z ズームパラメータに設定されます。

整数 ここに指定した整数番号の面データが自動的にコピーされます。(ピックアップ機能)。

THR参照面間隔を指定します。グローバル参照を指定しているとき、参照面されている面

(つまり基準座標系を提供している面)から、この面 (参照している面)までの距離を指

定します。

TLM ティルトモード: 後に続く面の座標を定義します。以下の 4つのモードがあります。

DAR ディセンター & リターンです。光学系の偏芯後、座標径だけが元の軸に戻

ります

NAX ニューアキシスです。新しい座標系を定義します

BEN ベンドです。反射の法則にしたがった方向に新しい座標径が定義されます

NOR ノー・レイトレースです。この面には光線追跡されません。座標変換の定義

のためだけに使われます。

SEQティルト/シフトの順番:ティルト/シフトさせる順番を設定します。“X”, “Y”, “Z” はシ

フトを表し、“A”, “B”, “C” はそれぞれ X 軸/ Y 軸/ Z軸まわりのティルトを表します。

例えば、“XYZABC” のように記述することで、偏芯操作の順序を指定します。特に指

定のない場合、デフォルトの設定は “XYZABC” の順です。

Pik この面のシフト/ティルトをピックアップする別の面の面番号を指定します。ティルト/

シフトに関するすべてのパラメータがピックアップされます。負の面番号を指定する

ことで、逆向のシフト/ティルトを指定できます。

XDE X軸に沿ったシフト

YDE Y軸に沿ったシフト

ZDE Z軸に沿ったシフト

ADE X軸まわりのティルト

BDE Y軸まわりのティルト

CDE Z軸まわりのティルト
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3.4.3 非球面 (Asphere)

非球面に関連したパラメータを入力するには 3つめのタブをクリックします。ここで指定

できる非球面は Z軸を回転対称軸とする多項式で記述されます。コーニック面 (放物面、楕

円面、双曲面)および、それらをベースカーブとする高次非球面が指定できます。このほか、

トロイダル面もこのシートから定義できます。

各パラメータ (A、B、C、D、E、F、G、H、RDX)の右側にある欄 (メニューバー上では

“・” で表示)には以下の内容が入力できます。

v 最適化の変数に指定 (シングルポジション)

z 最適化のズーム変数に指定

Asph.Type 高次非球面係数を選択します。“EVEN” と “ODD”、“ODD30”、“XYP” は、この面に

適用する非球面方程式のタイプです。詳細は、リファレンスマニュアルを参照してく

ださい。

　

K 高次数非球面のベース曲面を構成するコーニック定数 (円錐係数)K です。

K < −1 双曲面

K = −1 放物面

−1 < K < 0 長軸まわりの楕円面

K = 0 球面

K > 0 短軸まわりの楕円面 (偏球面)

A,B,C,D,E,F,G,H 高次非球面係数です。

RDX トロイダル面の X/Z面内の曲率半径です。ここに “0” 以外の値を入力することで X/Z

面内と Y/Z面内の曲率半径が異なることを指定できます。

3.4.4 屈折率分布型レンズ (GRIN)

屈折率分布型 (GRIN)レンズの光学特性を評価します。
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GRIN-Type 屈折率分布のタイプ。屈折率分布それぞれに応じて定義式があります。

URN ロチェスタ大学型のGRIN

SEL 日本板硝子社の SELFOC型の屈折率勾配

LPT LightPath社の GRADIUM型の軸上GRIN

AXG 軸上線形GRIN

LUN Lunberg Lens

SPG 球状GRIN

MAX Maxwell の魚眼

GLC Gradient Lens社のGRIN　 (EndoGRIN)

Step 光軸方向分割ステップ長です。これを小さく設定するほどGRINレンズ内の光線追跡

の精度は向上しますが、より多くの計算時間を要するようになります。

Z-Offset Zオフセット (LPTタイプのみ)。

GXDEX軸に沿ったGRIN特性のシフト

GYDEY軸に沿ったGRIN特性のシフト

GZDEZ軸に沿ったGRIN特性のシフト

GADEX軸まわりのGRIN特性のティルト

GBDEY軸まわりのGRIN特性のティルト

GCDEZ軸まわりのGRIN特性のティルト

Coeff. ユーザー定義GRIN面の屈折率分布係数を編集するためのダイアログを開きます。

このオプションは指定された面がユーザ定義GRIN面である場合、すなわち、ガラス名

として “GRIN” が設定されている場合のみ選択できます。屈折率分布面のタイプ (GIT

コマンドでも設定可能)は URN、LPT、UDGのいずれかでなければなりません。

MXGGRIN材料を追跡する光線の繰り返しステップの最大値です。MXG はGRIN媒質中の

光線追跡の繰返しステップの最大値を設定するために使います。この機能は不適切な

屈折率分布係数の入力 (とりわけユーザ定義分布の場合)によって光線追跡が無限ルー

プに陥った場合にそなえるものです。光路をステップ長 dsの微小光線要素で分割しな

がら光線追跡をする際、微小要素の数がここで設定する値を超えた時点で光線追跡を

強制的に終了させます。もしゼロ (MXG 0)が設定された場合にはこのチェックは行わ

れません。デフォルト値は 5000です。
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3.4.5 ソルブ (Solves)

ソルブとは、近軸光学的な特性を直接に制御するための機能です。ソルブの機能を使って

設定できる近軸光学的な条件には、光線角度維持、光線高さや入射角度の指定等がありま

す。ソルブ機能はこれらの条件を満足するようにレンズデータを変更します。“Solves”と名

付けられたタブのついたシートを使えば、ソルブのためのパラメータを指定できます。

Solve-type ソルブのタイプです。どの近軸特性を達成すべく要求するかを指定します。

指定可能なタイプは近軸光線傾角、近軸光線高、面への近軸入射角、アプラナティッ

ク、コバ厚 (レンズのエッジ厚)です。1つの面には、2つのタイプまで指定できます。

Param.1 ソルブの要求値を指定するための 1つめのパラメータを、ここに指定します。ソ

ルブのタイプに応じて設定すべき内容は異なります。

Param.2 コバ厚をソルブとして指定する場合のみ、第２のパラメータを必要とします。こ

こにはコバ厚が維持されるべき面高さを指定します。

3.4.6 特殊なアパーチャ形状 (Special Apertures

“Standard Data”のタブからも、円形、楕円形、矩形のアパーチャを指定することができ

ました。ここ “Special Apertures”のタブでもそれを指定できますが、さらに多角形のアパー

チャを指定することもできます。これらはすべて、基本アパーチャとよばれます。このシー

トからは 1面につき 10個までの基本アパーチャを “OR” と “AND” 演算子を用いて論理的に

組合わせ、より複雑なアパーチャを設定できます。それぞれのアパーチャを透過あるいは遮

蔽に指定したり、各基本アパーチャの位置をローカルな座標系に対してシフトさせたり回転

させたりする指定もできます。

このシート (図 3.8)を閉じるか、あるいは左端にある “Select surface” のドロップダウンリ

ストから他の面番号を選択したとき、それまで開いていた面のアパーチャ情報の更新が有効

になります。その際、少なくとも 1つの基本アパーチャ(もっとも一般的には円形開口)が選

択されなくてはなりません。基本アパーチャを選択するには所望のアパーチャの “On” の欄

をクリックすることで、チェックマークを付けます。光線追跡の際に有効になるのは、この

欄にチェックをつけた基本アパーチャだけです。

多角形を編集するには “Select surface” 欄で、“polygon” を選択します。すると、右側の

“Polygon” 欄がアクティブになります (この欄の表示が濃い灰色から、薄い灰色に変わり、こ

こに位置しているボタンが押されたように見えます）。そこで、このボタンをクリックする

と、多角形編集 (“Polygon Aperture”) ダイアログボックスが開きます。開いたダイアログに

多角形の頂点座標を設定してください。その際、最後の頂点座標を最初の頂点座標に一致さ

せるように注意してください。
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図 3.8:特殊アパーチャの編集 (多角形定義の場合には別ウインドウが開きます)

3.4.7 ホログラム (Hologram)

ホログラフィック (HOE)面は回折面とも表記されます。その光学特性は、光線通過点にお

けるローカルな有効格子間隔によって記述される、グレーティングの回折を基本に議論され

ます。OpTaliX ではグレーティング (回折格子)をホログラフィック面の特別な場合である

として扱います。

OpTaliX では、以下のホログラフィック面が扱えます。

• 格子定数がグレーティング面全体に渡って一様な線形グレーティング

• 格子定数がグレーティング面の位置に依存するVLS(Variable Linear spacing)グレーティ

ング

• 2つのビームの干渉によって生成される、光学的ホログラム

• ユーザ指定の回転対称性を持つ計算機ホログラム (CGH / Computer Generated Hologram)

• ユーザ指定の非対称な 2次元位相分布を持つ計算機ホログラム (CGH / Computer Gen-

erated Hologram)

• スウェットモデル (高屈折率法による回折素子モデル)

ホログラムのタイプはダイアログの右方にあるオプションボタンから選択します。どのタ

イプを指定した場合も、設計波長と回折次数の入力が必要です。
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図 3.9:ホログラム係数の編集画面

ホログラム係数は波面の位相変化を表します。その１次微分はホログラフィック面のロー

カルな格子定数を意味します。線形グレーティングの場合には一次微分が定数なので格子定

数 (溝本数/mm)は低次のホログラフィック係数そのものとなります。このため、線形グレー

ティングをホログラムとして設定するのはごく簡単です。

3.5 新規レンズデータの設定 (Entering a new System)

最初の簡単な例題として、２枚構成の色消しレンズを取り上げます。これをまったく最初

から入力してみましょう。この場合、レンズデータだけでなく、それを含むすべてのシステ

ム構成データを入力する必要があります。ここで、本書とリファレンスマニュアルの両方に

共通の用語として、“システム構成データ” の意味を明確にしておきます。これはレンズその

ものに付随するすべての光学データ (レンズデータ)と、そのレンズの使い方に関するデー

タの全体を意味します。システム構成データの典型的な例に、曲率半径、アパーチャ径 (こ

れらはレンズデータ)、画角、波長 (これらはレンズの使い方に関するデータ)があります。

さて、いまから入力するレンズは開口径が 30mmで、画角は ± 1度、物体は無限遠にある

とします。

図 3.10:色消しダブレットレンズの例
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下記に示す操作手順では、まず、メニューを用いた操作 (GUI)方法を説明し、その後コマ

ンド入力のみを使った操作方法について説明することにします。

3.5.1 メニューからの操作 (Menu Entry)

新しいレンズデータを設定するために、それまでのデータをきれいに消去します。メニュー

の File → Newを選択するか、またはツールバーアイコン をクリックします。

次に面データを入力します。メニューの Edit→ Surface Dataを選択するか、または、こ

のアイコン をクリックして面エディタを開きます。物体面 “OBJ” と絞り面 “STO”、それ

に像面 “ IMG” に対応した 3行だけが表示されます

ダブレットレンズの場合には、全部で 6面を定義することになります。レンズ面が 4面と

物体面および像面が各 1面です。(この例では絞り面をレンズ面上に置くことにしますので、

絞り面を総面数のカウントには加えません。しかし、レンズ面と独立に絞り面を定義する場

合 –実際よくあります–には、全部で 7面を定義する必要があります)

(絞り面を含めて)全部で 4面の定義するには、あと 3面をレンズデータに追加しなくては

なりません。そこで “IMG” と記された列 (の任意の入力欄)でマウスをクリックしてこの行

にカーソルを置き、次にシート下端の [Insert Surface]ボタンを 3回押して、あらたに 3面分

(3行)を挿入します。最少限のレンズデータとして、各面の曲率半径、面間隔、材料名を入

力します。“APE-Y” 欄 (面の有効径指定)は “0” のままにしておきます。この値は後で自動的

に計算されます。面エディタがつぎのように表示されるように、データを入力してください。

第 4面の面間隔 (Distance)は、レンズの最終面と像面との間の光軸に沿った距離、つまり

像距離を意味しています。もし面エディタの下部にある “PIM” のチェックボックスをチェッ

クすると、像距離は入力操作をしなくても値を持ちます。これは像面位置が近軸像点に一致

するように OpTaliX が最終面の位置 (第 4面の面間隔)を自動的に計算・設定するからで

す。“PIM” がチェックされていない場合には、最終面の面間隔は一定値を保ったまま変化し

ません。この場合には、ユーザが所望の値を適切に設定しなくてはなりません。

次に波長や開口径など、レンズの使い方を決めるデータを設定します。それには Edit→
Configuration dataを選択するか、またはツールバーアイコンから のボタンをクリックし
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て設定ダイアログ “Optical System Configuration” を開きます。入力用のシートがいくつかの

タブによって分類されています。

まず、“Aperture” タブを選択すると左上部に現れるラジオボタンを使って。光学系全系の

開口を定義する方法を選択します。ここでは入射瞳径を使って開口を定義することにしま

す。シート上の [Entrance aprture(EPD)]のラジオボタンをクリックし、つぎにその下にある

数値入力欄 Aperture valueに所望の値 (ここでは 30.0mm)を入力します。それから絞り位置

を確認します。Stop Surfaceの欄に 1と表記されていますか？　もし、そうでなければ第 1

面以外の面に絞りが設定された状態になっていますから、入力欄のすぐ右にある上下の矢印

ボタンを押して修正してください (または現在入力されている数値をドラッグし、表示色を

反転させた後、キーボードから直接に面番号を指定してください）。その他の設定は、その

まま変更しません。

画角は “Field” タブから設定します。ここでは最大画角±1◦を 3つの画角 (0, 0.5, 1◦)に分
割することにします。画角数を “No. of Fields” の欄に 3と指定し、次に画角を “Field Y” の

欄に入力します。さらに “Active” と書かれたチェックボックスをクリックしておきます。い

ま入力した値は、“半角”、つまり光軸と物点の X座標および Y座標とがそれぞれなす角度

ですから、シート向かって右側の Field Definitionのラジオボタンのうち、Object Angleをク

リックして、そのことを明確に指定してください。この例のように物体距離が無限遠のとき

の視野指定や、常に半角を Xと Yの成分で指定します。これ以外のデータは、この例では

変更しません。
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次に “Wavelength” タブから波長を定義します。水銀の緑線輝線の波長である 546nmを入

力しましょう。OpTaliX では波長の単位を µmで扱いますので、“Wavelengths” と書かれた

入力欄に “0.546”と入力します、続けて 450nmと 650nmを設定するために “0.450”、“0.650”

と入力します（波長の指定順序に制限はありません。OpTaliX はどんな順序でも受け入れ

ます)。それから、“No. of Wavelengths” に波長の数、3を設定さらに近軸性能を計算する際
に用いる波長 (主波長)を “Ref” 欄から選択します。ここでは一番目の波長 (546nm)のまま

にしておきます。重み “Weight”は、レンズに入射する光のスペクトル分布に対応させます。

これは色収差に関連した性能をシミュレーションするために使用されます。“0” から “100”

までの整数を入力します。指定した重みは相対的な量として認識されますから、その絶対値

は重要ではありません。すべての波長に “1” を入力するとフラットなスペクトル分布を前提

としたことになります。
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以上で、必要とされる全てのパラメータが定義されたので、“OK” ボタンを押してダイア

ログボックスを閉じます。

ここで、入力したデータを確認するためにレンズデータを出力表示しましょう。メニュー

から List→ Surfacesを選択するか、あるいは のアイコンをクリックすると、以下のリス

トがテキストウインドウに表示されます。

FILE = new_lens

Remarks:

Wavelength : 0.54600 0.45000 0.65000
Weight : 2 1 1
REF = 1

XAN 0.00000 0.00000 0.00000
YAN 0.00000 0.50000 1.00000
FWGT 100 100 100

PIM = no
SYM = yes
EPD = 30.0000

# TYPE RADIUS DISTANCE GLASS INDEX APE-Y AP CP DP TP MP GLB
OBJ>S Infinity 0.10000E+21 1.000000 0.00 C 0 0 0 0 0
STO S 119.1653 5.00000 BK7 1.518726 15.00 C 0 0 0 0 0

2 S -137.1862 1.50000 1.000000 0.00 C 0 0 0 0 0
3 S -121.7583 3.00000 SF6 1.812665 0.00 C 0 0 0 0 0
4 S -230.8567 0.00000 1.000000 0.00 C 0 0 0 0 0

IMG S Infinity 1.000000 0.00 C 0 0 0 0 0

Paraxial Data:
EFL 200.00000 SEP (Entr.Pup.Loc.) 0.00000
BFL 194.18610 EPD (Entr.Pup.Dia.) 30.00000
FNO (F-Number) 6.66667 SAP (Exit Pup.Loc.) -6.48230
MAG (Magnification) 0.00000 APD (Exit Pup.Dia.) 30.10026
DEF (Defocus) 0.00000 SH1 (Princ.Plane 1) 0.66618
NAO (Num.ape.object) 0.00000 SH2 (Princ.Plane 2) -5.81390
NA (Num.ape.image) -0.07479 SYL (System Length) 9.50000
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S0 -0.1000000E+21 OAL (S1->Image) 9.50000
OID (Object->Image) 0.10000E+21 PRD pupil relay dist 3.01770

“Paraxial Data”の EFLの項から、このレンズの焦点距離がほぼ 200mmであることが分

かります。もし、同じ操作をしても焦点距離が一致していなかったとしたら、それはレンズ

データの入力のどこかに誤りのあることを示しています。もう一度、入力した値を確認して

ください。

さて、出力に現れたレンズデータのうち、定義されていないパラメータは第 2面から 5面

までの面アパーチャです。この値をユーザが設定する必要はありません。“MHT” コマンドに

より、すでに設定してあるシステム構成データから、OpTaliX が各面の最大光線高さを計

算し、ここに補います。この計算はメニューの Tools→ Set maximum heightsを選択するか、

あるいはアイコン をクリックしても実行できます。

最後のステップとして、レンズレイアウトを描画します。メニューのDisplay→Lens Draw

Yを選択すると、図 3.10が描画されます。

3.5.2 コマンドラインからの新規レンズの作成 (Command Line Entry)

ここでは前章の内容をコマンドだけを使用して操作します。“!” の後は説明のためのコメ

ントであって、コマンドの一部ではないので、入力の必要はありません。

len ! ここでは前章の内容をコマンドだけを使用して操作しま

す。“!” の後は説明で、コマンドの一部ではありません。

ins s1..4 ! 最終面の前に 4枚の面を挿入します。Sの次の 1は数字の

1です。アルファベットの L(の小文字)ではありません。

曲率半径、面間隔、材料等の面データを入力します。

rdy s1 119.1653 ! 第 1面の曲率を指定します。

thi s1 5 ! 第 1面の後の面間隔を指定します。

gla s1 bk7 ! 第 1面のガラス材料を Schott BK7に指定します。

第 2面から第 4面までの面データ入力を繰返します。

rdy s2 -137.1862

thi s2 1.5

gla s2 ! 第 2面の後は空気です。

rdy s3 -121.3580

thi s3 3

gla s3 sf6

rdy s4 -230.8567
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光学系のアパーチャ、画角および波長を定義します。

epd 30 ! 入射瞳径を指定します。

yan 0 0.5 1 ! 3つの画角を 0、0.5、1◦に定義します。
wl 0.546 0.45 0.65 ! 3つの波長を定義します。

ref 1 ! 参照波長番号を 1に指定します。

set mht ! 必要な最大面高さを計算します。

リストを出力し、入力が正しいことを確認します。

lis ! リストを出力します。

レンズレイアウトを描画します。

vie ! Y/Z面を描画します。
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　このページは白紙です。
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第4章 例題練習 – Worked Examples –

4.1 面の偏芯 (Tilted Surfaces Example)

この例題では、OpTaliX にサンプルレンズとして登録してあるダブルガウスレンズ、

(Y=examplesY=miscY=double gauss.otx )を使って、面を偏芯させる方法を学びます。以

下の手順に沿ってOpTaliX を操作すると、下図のとおり最終レンズ面と像面との間に 45◦

反射ミラーを挿入できます。

図 4.1: “光線跳ね上げミラー” を持つダブルガウスレンズ

4.1.1 メニューからの操作 (Menu Entry)

まず最初にダブルガウスレンズを読み込みましょう。メインメニューの File→ Openを選

択し、OpTaliX をインストールしたフォルダ (通常はマイコンピュータのローカルディス

ク Cの Y=OpTaliX-Pro または Y=OpTaliX-LT ) の下にある “Y=examplesY=misc ” をたど

り、その中にある “double gauss.otx ” を選択し、OKをクリックします。次にメニュー

の Edit→ Surface dataを選択するか、あるいは アイコンをクリックして、面エディタを

開きます。

光学系は、物体面と像面を含めて 12面で構成されています。

ここで最終レンズ面の後ろに、折り返しミラーとなる新しい面を挿入します。新しい面は

選択した面の前に挿入されるので、最終レンズ面の後ろに面を挿入するということは、像面

の前に新しい面を挿入すればよいことになります。面エディタの “IMG” と記された第 12面

の列 (の任意の入力欄)にカーソルを移動して [Insert Surf]ボタンをクリックすると、新しい
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面が挿入されます。

今挿入した面が、新たに第 12面となり、光学系全体は 13面構成になりました。第 12面

を折り返しミラーとして定義するためには、いくらかパラメータを変更しなくてはなりませ

ん。まず、面タイプを変更します。現在、この面の “TYPE” 欄は、“S” となっていてますが、

これは、この面が球面として定義されていることを示しています。これはまさしく正しい表

現です。なぜなら、この面の形状、つまり平面は、曲率半径が無限大の球面だからです。さ

て、この特性を “偏芯を持つ反射面” に変更します。“TYPE” 欄に “SDM” と入力してくださ

い。ここで’‘ D” と “M” は次の意味を持ちます。

D : シフト/ティルト

M : ミラー

次にミラーの位置とティルト量を設定します。面エディタの “Decenter, Tilts” タブを選択し

ます。第 12面の偏芯タイプ “TLM” を “DAR” から “BEN” に変更します。これは、OpTaliX

が偏芯をどのように取り扱うべきかを指定するものですが、“BEN” モードの場合には、こ

の面よりも前方の光軸が、あたかも光線のように第 12面で反射したかのように折れ曲がり、

この面以降の新たな光軸となるよう扱うことを指定しています。

ティルト量は第 12面の “ADE(X 軸まわりの回転)” 欄に設定します。その単位は常に “◦

(度)” とし、ティルトの方向は正負の符号で定義します。

正符号: ティルトは反時計方向に生じます。

負符号: ティルトは時計まわりに生じます。

第 12面の “ADE” 欄に−45◦を入力するとミラー面は時計方向にティルトして、そこで反
射した光線は上向きに折れ曲がります。

最後に “Standard data” タブを選択して、第 11面の面間距離を 10mm (レンズ面と像面の

中間位置)に設定します。レンズの断面図を描画 (メニュー: Display→ Lens Draw Y)すると

図 4.1が得られます。

4.1.2 コマンドラインからの操作 (Command Line Entry)

ダブルガウスレンズのデータ (examples \misc \double gauss.otx )がすでに読み込

まれていると仮定して説明します。最終結果は図 4.1に示したものとなります。折り返しミ

ラーをダブルガウスレンズの最終面と像面の間に挿入し、跳ね上げミラーとして定義するに

は、次の一連のコマンドを入力します。
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ins s12 第 12面 (像面)の前に新しい面を挿入 (像面の番号は 13に繰

り下がります)。

sut s12 SDM 第 12面の面タイプを球面 (S)/偏芯 (D)/反射面 (M)に定義。

ben s12 ティルトモードを “BENd”(反射の法則に従う光軸定義)に変

更。

ade s12 -45 X軸中心ティルト角度を 45◦ (時計回り)に設定。

thi s11 10 第 11面の面間距離を 10mmに設定。

vie Y/Z面でのレンズ描画。

4.2 非球面レンズ (Aspheric Surfaces Example)

この例では、レンズ性能を向上させるために非球面がどのように用いられるかを学びます。

そのための題材として下図に示す単レンズ (Y=examplesY=tutorialY=BestformLens.otx )

を使用します。このレンズは単レンズとしては最良の性能を持ったもの (ベストフォームレ

ンズ)ですが、しかし、大きな球面収差が残っています。そのことは、アイコン をクリッ

クするか、コマンドラインから ’ fan ’ と入力することで作成される横収差図や、 をク

リックするか、コマンドラインから、’spo ’ と入力することで作成されるスポットダイアグ

ラムで確認できます。

ここでの目的はレンズの第 1面に非球面を導入することで、この球面収差を減少させるこ

とにあります。

非球面を指定するには、面タイプを “A” にします。もともとの面タイプは “S” ですから、

これを置き換えるわけです。“S” は OpTaliX に対して、この面を球面として取り扱うよう

に指示します。“A” は非球面として取り扱うことを指示しますから、いずれか一方だけ (こ

こでは “A”) を指定します。

図 4.2:非球面化の元となる球面ベストフォームレンズ

4.2.1 メニューからの操作 (Menu Entry)

面エディタにて、第 1面の面タイプ “TYPE” 欄を “S” から “A” に変更します。第 1面には

絞り面でもあるので、“STO” と表示されています。

ここでは説明を簡単にするため、非球面定数としてコーニック定数だけを扱います。した

がって、今、この面が取り得る面形状は、双曲面、放物面、楕円面、球面 (コーニック定数
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をゼロに設定した場合)、偏球面 (短軸まわりの楕円）のいずれかに限定されます。

“Asphere” タブを選択して、第 1面のコーニック定数 “K Conic.Const.” の欄 (2行目)に

“−0.7106137” を入力します (図 4.3参照)。

面エディタでの入力値は、[Enter] キーが押された時、またはカーソルが別のセルに移動
したときに確定されることに注意してください。

図 4.3:非球面係数の入力画面から、コーニック定数の入力

収差図とスポットダイアグラムを再描画してみると、収差はほとんど判らない程度に減少

していることが分かります。収差図のスケールを変更するために、収差図を描画しているウ

インドウの左端にみえるアイコン をクリックし、そこに現われるダイアログボックスで

“0.001(mm)”を設定します。今度は、わずかな残存収差が見えます。

高次の非球面係数を入力すれば、このわずか残存収差もなくす事ができます。これらの係

数は “A” から “H” までのアルファベットで示されています (図 4.4参照)。ここで係数 “A” か

ら “C” に下記の数値を入力します。

A 0.14294664E-08

B -0.23156870E-12

C 0.99999337E-21

図 4.4:非球面係数の入力画面から、高次非球面係数の入力

更に高次の係数 (D-H)も入力できますが、この例題に関する限り、球面収差に関してはほ

とんど改善に寄与しません。

4.2.2 コマンドラインからの操作 (Command Line Entry)

コマンドラインからは以下のとおり入力すれば、題材とするレンズデータを読み込めます。
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res c:Y=optixY=examplesY=tutorialY=BestformLens.otx

ただし、これはOpTaliX が c:Y=optalix ディレクトリにインストールされている場合

です。

面タイプを非球面に変更し、さらに非球面係数を設定するには、以下のコマンドを入力し

ます。

sut s1 a ! 面タイプの変更 (非球面指定)

k s1 -0.7106137 ! コーニック定数の入力

A s1 0.14294664E-08 ! 高次非球面係数の入力

B s1 -0.23156870E-12 ! 高次非球面係数の入力

C s1 0.99999337E-21 ! 高次非球面係数の入力

4.3 屈折率分布型レンズ (Gradient Index (GRIN) Example)

非球面を導入した場合と同様に、屈折率分布 (GRIN)材料を使用して単レンズの軸上性能

を向上させることもできます。ここでは、その具体的な操作を学びます。前章と同じように、

単レンズ (Y=examplesY=tutorialY=BestformLens.otx )を題材とします。これを元に、

2つのレンズパラメータを変更します。ひとつはガラス材料、もうひとつは “Z オフセット”

と呼ばれる量です。Zオフセットとは、面のローカル座標を基準として、屈折率分布の基点

を示すパラメータです。

4.3.1 メニューからの操作 (Menu Entry)

面エディタの “Standard Data” タブを開き、第 1面のガラス材料としてGradiumTM 社の屈

折率分布型ガラス、“G51SFN”を入力します。あらかじめOpTaliX に登録されたGRIN材

料を指定した場合、面タイプおよび屈折率分布のタイプは自動的に変更されます。この例題

では、面タイプが “SI” ( S:球面、I :屈折率分布型)に、屈折率分布タイプは “LPT”(LightPath

社定義プロファイル)に設定されます。

次に、“GRIN” タブ内の第 1面 (STO表示)の “Z-Offset” 値として “1.854”を入力します。

収差図を表示してもともとの収差と比較すると、飛躍的な改善が確認できます。僅かに残る

収差も、最適化機能を用いて微調整すると更に減少できます。最適化機能は別の章で説明し

ますので、ここでは最適化で得られた以下の値を入力してください。

第 1面の曲率半径 (rdy s1) : 172.068240

第 2面の曲率半径 (rdy s2) : -889.854031

Zオフセット (Z-offset) : 5.89166

デフォーカス量 (thi si ) : 0.03670
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4.3.2 コマンドラインからの操作 (Command Line Entry)

入力済みの単レンズをGRINレンズに変更し zオフセットを定義するには、以下のコマン

ドを入力します。

gla s1 g51sfn

gzo s1 1.854

より良好な収差をもつレンズデータ (あらかじめ最適化によって得られたパラメータ)を入

力するには、さらに、以下のコマンドを入力します。

gla s1 g51sfn

gzo s1 5.89166

rdy s1 172.068240

rdy s2 -889.854031

def 0.03670

4.4 グレーティング (Diffraction Grating Example)

グレーティングに関する例題は、次バージョン以降のチュートリアルに記載します。チュー

トリアルの改訂版は、ウェブサイト http://www.optenso.de/　または http://www.ekklesia.co.jp/

のダウンロードページからダウンロードできます。

グレーティングの機能に関する詳細は、リファレンスマニュアルを参照してください。

4.5 ソルブの例 (Solves Example)

ソルブとは、近軸量を直接、かつ正確に制御するための機能です。ソルブの例として、近

軸光線の光軸に対する傾角の維持、、近軸光線の各面における高さ (光軸からの距離)の確保、

面への光線入射角度を指定値に設定などがあります。ソルブ機能はこれらの指定が常に満た

されるようにレンズデータを自動的に変更します。つまり、ある面を出射する近軸光線の傾

角が所定の値となるようにソルブを指定すると、その条件が維持されるように面の曲率半径

が自動的に計算され、レンズデータにセットされます。同様に近軸光線の高さをソルブとし

て指定すると、指定した条件が満足するように面間隔が変更されます。光学特性の評価像面

を常に近軸像面に一致させるという PIMの機能も実は、ソルブの一種です。ソルブは、レ

ンズパラメータ (曲率半径や面間隔)が変更されても、常にその機能を維持します。

注意点としては、ソルブは近軸量だけに作用している、ということです。実光線が持つ収

差の影響は考慮していません。また、ソルブはピックアップの機能と併用できません。詳細

については、リファレンスマニュアルを参照してください
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4.6 特殊なアパーチャ形状の例 (Special Apertures Example)

特殊なアパーチャ形状に関する例題は、次バージョン以降のチュートリアルに記載します。チ

ュートリアルの改訂版は、ウェブサイト http://www.optenso.de/　またはhttp://www.ekklesia.co.jp/

のダウンロードページからダウンロードできます

特殊なアパーチャ形状の設定方法は 3.4.6章に説明があります。さらに詳しい説明は、リ

ファレンスマニュアルを参照してください。

Tutorial OpTaliX



40 例題練習

4.7 ズーム光学系 (多重構成系) (Zoom Example)

構成する素子が同一で、その配置だけが異なる光学系を一般的にズームレンズと呼んでい

ます。これは多重構成系の一種です。OpTaliX は、古典的な意味でのズームレンズだけで

なく、以下に挙げるような様々な構成の可変光学系を設計/解析できます。これらはいずれ

も、ここで議論する多重光学系に属する光学系です。

• 古典的ズームレンズ (レンズ間隔だけが可変であるような多重構成系)

• スキャニング光学系 (面ティルトとシフトを可変要素とする多重構成系)

• 多波長光学系 (波長や、その他、取り扱うスペクトルそのものが変化するタイプの光

学系、分光器など)

• 表示光学系における目の位置変化 (ヘッドアップ・ディスプレイなど)

• 多重共役系 (マクロレンズなど)

• 光学系の一部が入れ替わったり、一部を着脱するタイプの光学系

この章では “ズーム” という言葉を、レンズパラメータの一部が変化する、あらゆるタイプ

の光学系という意味で使用します。ズームポジションの数は無制限に指定できますが、ズー

ムデータ用のスプレッドシートを使って編集できるのは、最大 30ポジションまでです1。

ズームデータはレンズデータの一部として保存されます。また、ズームを解除 (デズー

ム:de-zoomして、任意のポジション (任意のズーム配置)だけを通常のレンズデータとして

取り出すこともできます (dez コマンド )。

通常、ズーム光学系の設定のベースとなるスタートデータは、ズーム化されていないレンズ

です2。ここではダブルガウスレンズのデータ (Y=examplesY=miscY=double gauss.otx )

を使用します。

ズームポジションの数は、次のコマンドで設定します。

zoo N

Nがズームポジションの数です。ここでは “zoo 3 ” と入力してみましょう。この指定は、

OpTaliX にレンズデータをズーム系に関するとものとして取り扱い、このあとズームパラ

メータを受け付けるように指示しています。同じ指示をアイコン をクリックすることに

よって行うこともできます。いずれの場合も、ズームパラメータを入力するためのスプレッ

ドシートが開きます。

ズームパラメータに関する定義はいつでも次の書式で行えます。

130以上のポジションについてズームパラメータを編集するには、ZEDコマンドで起動する専用のテキスト
エディタを使います。

2これを “固定焦点レンズ” と記述することもあります。この呼び方は、すべての構成データが定数として固
定されているからです。とりわけズーム系の最適化において、この言い方がよく使われます。詳しくは 6.2章を
参照してください。
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図 4.5: “ZOO 3” コマンド実行すると、空欄のズームエディタが開きます。すべてのセルが

見えない場合にはウインドウをドラッグして拡大します。

variable SFW parameter 1 parameter 2 ... parameter n

ここで SFWは所望のズームパラメータを意味する名称、たとえば rdy (曲率半径)、ade (X

軸まわりティルトなど)と、その対象を具体的に示すためのパラメータ、たとえば “sk ”(面番

号)、“ fk ”(画角番号)、“wk”(波長番号)などからなります。

ズームパラメータとして物体距離を定義するには、例のようにします。

まず、物体距離をズームパラメータとして認識させるため、

zoo thi s0

と入力します。それ以降は

thi s0 200 150 100

と入力します。この操作によって、第 0面の面間隔 (すなわち物体距離)が 3つのズームポ

ジションに対してそれぞれ設定されます。

このコマンドに対応する、スプレッドシートからの入力の様子を図 4.6に示します。

図 4.6:スプレッドシートからの入力。物体距離 (THI s0 )をズーム化する場合

このままレンズの断面図を描画すると (vie コマンド)、3つのズームポジションが重ね書

きされるため、線が交錯して見にくくなってしまいます (図 4.7参照)。

断面図の重なりを避けるには、それぞれのズームポジションを任意の別々の位置に配置す

るように指定します。描画位置を制御するために、3つのコマンド (POX, POY, POZ)を使い
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DOUBLE GAUSS - U.S. PATENT 2,532,751

File = DOUBLE_GAUSS.OTX Scale = 0.7225 Y/Z-view

138.4098 mm

図 4.7:全ズームポジションに渡るレンズ描画。すべてのポジションが重ね書きされた例

ます。これらは、それぞれレンズ空間における移動方向を示しています。設定単位はmmで

す。これは描画スクリーン上における移動量です。

ズームレンズ系の描画において (POX, POY, POZ)を使う場合、これら自身をズームパラ

メータとして指定します。たとえば、

zoo poy

と入力し、その後は、

poy 50 0 -50

のように指定します。メニューから指定する場合は図 4.8に示すようにOption→ Append

rowとたどって入力行を 1行追加し、図 4.9のとおり描画位置を指定します。

図 4.8:ズームパラメータを定義する行の追加手順。Option→ Append rowとたどります。
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図 4.9:描画位置のオフセット。POYコマンドを用いて、描画画面内の任意の位置に描画位

置を移動させます。オフセット量は描画紙上の座標 (mm)で指定します。

以上の操作により、最終的に描画される断面図はは図 4.10のようになります。

DOUBLE GAUSS - U.S. PATENT 2,532,751

File = DOUBLE_GAUSS.OTX Scale = 0.7225 Y/Z-view

138.4098 mm

図 4.10:全ズームポジションに渡るレンズ描画。ポジションごとに描画位置を調整した場合
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　このページは白紙です。
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第5章 その他のオプション

– Special Options –

5.1 マクロ (Macros)

OpTaliX のコマンドを並べて記述したものをマクロといいます。OpTaliX にはこれを

逐次解釈して実行するマクロ機能が実装されています。この機能を使えば、OpTaliX の内

部データベースを参照してレンズの特性量を引用できます。また、それを数式表現と組み合

わせてコマンドのパラメータとして指定することもできます。マクロ機能を使えば、各種の

計算や解析を自動化できます。

マクロに関する例題は、次バージョン以降のチュートリアルに記載されます。チュートリ

アルの改訂版は、ウェブサイト http://www.optenso.de/または http://www.ekklesia.co.jp/のダ

ウンロードページからダウンロードできます。

マクロ機能に関する詳細は、リファレンスマニュアルを参照してください。

5.2 ユーザ定義グラフィック (User Defined Graphics (UDG))

ユーザ定義グラフィクスを使えば、任意のレンズパラメータの変化に対する、任意の光学

特性量の変化を示す、2次元グラフを簡単に作成できます。

ユーザ定義グラフィクスに関する例題は、次バージョン以降のチュートリアルに記載されま

す。チュートリアルの改訂版は、ウェブサイト http://www.optenso.de/ または

http://www.ekklesia.co.jp/のダウンロードページからダウンロードできます。

ユーザ定義グラフィクスに関する詳細は、リファレンスマニュアルを参照してください。

5.3 ユーザ定義面 (User Defined Surface (UDS))

ユーザ定義面に関する例題は、次バージョン以降のチュートリアルに記載されます。チュー

トリアルの改訂版は、ウェブサイト http://www.optenso.de/または http://www.ekklesia.co.jp/

のダウンロードページからダウンロードできます。

ユーザ定義面に関する詳細は、リファレンスマニュアルを参照してください。
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このページは白紙です。
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第6章 最適化 – Optimization –

最適化とは、いくつかのレンズデータ (変数)の値を変えることで所定のアプリケーション

に十分に適合するように、収差を最小化するプロセスのことです。

この章では、OpTaliX で使用している最適化手法の概念と、ゴールに到達するために必

要なすべての手順について説明します。最適化のアルゴリズムなど、さらに詳しい解説は、

リファレンスマニュアルを参照してください。

最適化の準備を滞りなく行うには、変数とメリット関数を定義する必要があります。変数

としては通常、曲率半径、面間隔、ティルト角等が使用されます。光学系の性能は、ユーザ

定義エラー関数 (一般にこれを “メリット関数” と呼びます)で評価します。メリット関数は

設計目標値と性能評価値との差で表されます。一般にメリット関数の値が小さいほど、光学

性能が高いことを意味します。

最適化は、変数の値を繰り返し変化させながらメリット関数がより小さくなる変数の値

を見つけ出す反復プロセスです。そのため、もっとも最初にすべき作業はスタート地点とな

るレンズデータの設定です。OpTaliX に登録されているサンプル・ライブラリは適当なス

タート地点を選ぶために有用です。

OpTaliX で使用している最適化アルゴリズムは極小値探索法ですので、収差がどの程度

まで改善できるかは (つまり最終的な設計解の良し悪しの程度は)、初期地点の選択 (つまり

スタート地点としてのレンズデータに選択)に強く依存します。変数がただひとつの場合を

例にとって、このことを図 6.1に示します。

������

���

図 6.1:変数とメリット関数の関係：スタート点をAにとるか、Bにとるかによって得られ

る設計結果の良し悪し (メリット関数の大きさ)が異なります。

通常のレンズ設計は変数の数は１つでは済みませんし、極小値の数も多数あるので、ス
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タートデータの選択はたいへん重要です。図 6.1において、設計前の出発点である A点と B

点はメリット関数が同じ値をとっていますが、最適化の結果は異なった極小解 (別の設計デー

タ)に導かれています。レンズ設計の本質的な目的がメリット関数の最小値を探し出すこと

だとすると、そのプロセスと成否はスタートデータの選択を含む設計者の能力と経験に依存

しますが、OpTaliXの自動設計機能は、それを引き出す役割を演じます。

ここで最適化を実行するための手順を確認しておきます。以下の順に説明します。

a)変数の定義

b)メリット関数を構成する設計目標 (目標関数)と制約条件の定義

c)最適化の実行

6.1 固定焦点レンズの最適化 (Fix-Focus Lens Optimization)

この章では、Buchroeder型のアポクロマートレンズ (用途は天体望遠鏡)を最適化します。初

期レンズデータとして “Y=examplesY=optimizationY=apo 0.otx ” を使用します。“FAN”

コマンドまたはアイコン をクリックすると表示される収差図を見ると、けして集光性能

が良くないことが判ります。これは、ここでの演習のためにオリジナルの Buchroederが提

案したレンズデータを故意に悪く変更してあるためです。

6.1.1 変数の定義 (Defining Variables)

“VAR” コマンドまたはアイコン をクリックして変数を定義します。図 6.2に示すダイ

アログが開きます。この例題ではすべての曲率を変数に定義のするので、第 1面から第 4面

の “CUY” のチェックボックス欄をクリックして、そこにチェックマークを付けます。

さらにデフォーカスも変数に指定します。これは具体的には像面 (IMG)の THI )にチェッ

クマークをつけるということです。一般に、最良像が得られる像面位置は近軸理論で決まる

像面位置とは一致しません。その原因は収差です。デフォーカスを変数として設定すること

によって収差を考慮した最良の像面位置の探査が許され、これが光学系の設計自由度として

加えられます。デフォーカス量を変数として指定することは設計性能を向上させるのに大い

に役立ちます。

6.1.2 評価関数 (The Merit Function)

メリット関数は、個別の光学特性を定義した収差の “目標値あるいは目標関数” と “制約

条件” から構成されます。目標関数には、たとえばスポットダイアグラムの直径 (SPD)や色

収差 (LAC) 等を設定します。一方、制約条件とは、所定の値に維持されるべきパラメータ

のことです。また、所定の値よりも大きい/小さい範囲にパラメータの値を維持するならば、

それを明示した条件もまた、制約条件といいます。制約条件には収差を指定することもあり
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図 6.2:変数/目標関数/制約条件を定義するダイアログボックス

ますが、より一般的には、近軸量や、レンズ構成データそのものが使われます。たとえば焦

点距離 (EFL)を所望の値に維持したり、あるいはレンズ全長 (OAL) を所定の値より小さな

範囲に維持したりする目的で使います。

Buchroederの例では評価関数の定義はいたって簡単です。“Variables/Targets”(変数/目標)

ダイアログで、次の値を入力します。

EFL = 1500 ! 焦点距離を 1500mmに維持する

SPD 0 ! スポットダイアグラムの RMS直径の目標値としてゼロを設定

この設定が意味するところは明白です。焦点距離 (EFL)を正確に 1500mmにしたままで、

スポットダイアグラムのRMS直径をゼロにしようと試みるということです。SPDの指定に

はパラメータが省略されています。このため、デフォルトの設定 (システム構成データとし

て設定されている全画角/全波長に関するスポットダイアグラム)が目標関数として最小化の

対象に設定されるのです。この例では評価関数をスポットダイアグラムの直径だけで構成し

ていますが、最初の例題としてはこれで十分です。実際の設計で使われているような、複数

の目標関数の組み合わせからなるメリット関数の定義については、改めて説明します。

図 6.3のとおり、メリット関数を構成する個々の目標関数や制約条件はダイアログボック

ス右上のリストボックスから選択できます。リストボックスの右にある “Add” ボタンをク

リックすると、そのとき、ボックス内に選択されていた目標関数がメリット関数の定義に追

加され、ダイアログボックス右下のエディタ部分に移ります。ただし、ここで追加されるの

は目標関数名だけですから、目標値や制約値などの数値パラメータを、演算子 (>,<,=)と
ともにキーボード入力により補わなくてはなりません。

このことを図 6.3の例で示します。ここでは目標機能 “EFL” だけが追加されますので、数

値と演算子 “= 1500”を入力して “EFL = 1500 ”のように完成させればよいのです (図 6.2も

参照してください)。

メリット関数の定義を終えたら、“OK” のボタンをクリックして、ダイアログボックスを
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図 6.3:リストボックスからの目標関数と制約条件の選択

閉じます。OpTaliX のほとんど全てのコマンドを目標関数として定義できます。例として、

SPOとコマンドラインから入力すると、RMSスポット径を出力するコマンドになりますが、

この” コマンド名” を” 目標関数名” と読み替えて最適化のメリット関数に加えると、スポッ

ト径を制御するための目標関数として機能します。目標関数の定義にあたっては、算術関数

(2*sqrt(2)/3 )やレンズデータベースアイテム (面間距離/曲率半径等)を組み合わせて指

定できます。例えば、次のような記述も問題なく通用します。

EFL = 2*750

あるいは

EFL = sqrt(1500)**2

最適化のための各種定義に使用できるコマンドや式表現に関する詳細は、リファレンスマ

ニュアルを参照してください。以上で最適化を実行するのに必要なパラメータは全て定義さ

れました。

6.1.3 最適化の実行 (Run the Optimization)

最適化を実行するには、コマンドラインから “OPT” と入力するか、あるいはアイコン

をクリックします。デフォルトでは最適化計算は 10回繰り返されます。最適化を実行した

際に得られる出力は、次のとおり、４つのブロックに分けて考えるとその内容を容易に理

解できます。

ブロック-1:変数と制約条件の数

KT Optimization:
Number of variables : 5
Number of functions : 900
Number of equality constraints : 1
Number of inequality constraints : 0

ブロック-2:最適化を実行する直前の、メリット関数の構成要素その値
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Targets/Constraints Target Function Error
efl = 1500. 1500.000000 1457.939417 -42.060583
spd 0 0.000000 0.038304 0.038304

ブロック-3:最適化の繰り返しサイクルごとのメリット関数の変化

Iter Min. Equal. Inequal. DumpingF. Improv.
0 0.906432 6.485413 0.000000 1.000000
1 0.268796 1.105826 0.000000 0.8133397E-02 0.70346
2 0.041503 0.102830 0.000000 0.8133397E-03 0.84560
3 0.027474 0.157272 0.000000 0.8133397E-07 0.33801
4 0.027454 0.003427 0.000000 0.8133397E-13 0.00073

Optimization stopped. Improvement is less than 0.01000 (1.00%)

ブロック-4:最適化の実行を終えた直後のメリット関数の構成要素とその値

Targets/Constraints Target Function Error
efl = 1500. 1500.000000 1500.000012 0.000012
spd 0 0.000000 0.001160 0.001160

図 6.4の収差図は最適化の効果を示しています。

0 . 0 0 0
0 . 0 0 0 d e g

d e g 0 . 0 0 0
0 . 0 0 0 d e g

d e g

���� ����

図 6.4:最適化前後の横収差比較　　注）もし実際に出力された横収差図が、この図の書式

と異なり長軸を水平線とするものであっても、それは本質的な問題ではありません。横収差

図において長軸は開口径に対応しており、それを水平線で表現するか、鉛直線で表現するか

は好みで決めてよいからです。その切り替えは、File→ Preferencesより ‘operations’タブを

選択すると現れる ‘Align ray fan curves horizontally’のチェックボックスにて行います。

6.1.4 設計例、接眼レンズの場合 (Example 2)

次の例は、単純な Ploesslタイプの接眼レンズの最適化です。

初期データの断面図は、図 6.5のとおりです。このデータはOpTaliX をインストールし

たフォルダの下の、“Y=examplesY=optimizationY=EYEPIECE 0.OTX ” にあります。

下記で議論する全ての最適化パラメータは、あらかじめ、ここで読み込むレンズデータの

一部として組み込んであります。前の節で扱った Buchroederのアポクロマートレンズの場
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合には、故意に非常に大きな収差となるようにレンズデータを変更してあり、それを補正す

ることが例題のゴールでした。この節のゴールは、単純な収差補正だけでなく、制約条件を

満足させながら光学性能を向上させることにあります。つまり、この例題のポイントは像側

テレセントリックを維持したまま収差補正をすることにあります。さらに具体的に言い換え

るならば、像面に向かう主光線を像面と垂直に維持するという制約条件下における収差補正

の方法を学ぶのが、ここでの目的だということです。

1

2 3 4 5 6 7

8

図 6.5: Ploesslタイプの接眼レンズ

射出光線をテレセントリックにするには、射出光線の進行方向を制約条件に加えるのが簡

単です。具体的には “CY” (方向余弦)コマンドを使います。キーボードから次のコマンドを

直接入力します。

CY s8 f2 w1 0 0 = 0.0

一見複雑に見えるかもしれませんが、基本概念を理解していれば簡単です。この設定は第

8面 (s8) /第 2画角 (f2) /第 1波長 (w1)において、入射瞳の中心 (直径を 1.0とする相対座標

で x = 0, y = 0)を通過する光線の Y方向余弦 (CY)対象としています。目標値がゼロ (0.0、

つまり光軸と平行)と設定されていますがその前に等号 (=)が記述されていることから、こ

の設定が単なる収差補正目標ではなく、制約条件として正確に解かれることを意図したもの

であることが読み取れます。

さらに、焦点距離を 25mmに維持して、全画角でのスポット径を最小にするように定義し

ます。メリット関数の定義は次式で記述されます。

efl = 25

CY s8 f2 w1 0 0 = 0

spd 0

自動設計のための変数として、は第 2面から第 7面までの曲率 (CUY)とデフォーカスを

指定します。図 6.6は変数/制約条件を編集するダイアログボックスに入力すべき内容を示し

ています。該当欄 (CUYの欄の第 2面から第 7面に相当する欄)と、像面の THI にチェック

が入っていることがわかります。このダイアログは、コマンドラインから “VAR” と入力す
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るか、あるいはメニューバーから をクリックすれば現われます。

図 6.6:変数/目標関数/制約条件を定義するダイアログボックス

KTアルゴリズムを用いて最適化を実行 (OPT KTコマンド)すると、軸外収差が飛躍的に

改善することが分かります。図 6.7にその比較を示します。最適化後のテレセントリシティ

を確認するために、次のコマンド (制約条件の定義から演算式の部分を除いたもの)を入力

します。

eva CY s8 f2 w1 0 0

テキストウインドを見ると、その結果として、y方向の方向余弦が-6.279830604638548E-06

と表示されます。これはおおよそ−0.00036◦に相当します。この値は一般的なほとんどすべ
ての用途に十分適合します。

6.1.5 最適化のための一般パラメータの設定 (Setting General Optimization Param-
eters)

“最適化のための一般パラメータ” の設定を調整すると、最適化のプロセスの振る舞いを

コントロールできます。たとえば、最適化のためのアルゴリズムを状況に応じて切り替えた

り、最適化を実行している最中に出力されるレポートに、何を記載するかを帰られます。

この章では、最適化プロセスをコントロールするためのパラメータについて示します。し

かしながら前章までの作業によって、最適化に対する妥当なパラメータ設定は完了していま

すからこの章で説明する変更をすぐさま適用する必要はありません。ですからこのまま次の

章に進み、あとでこの章を把握するという読み方でも何ら問題ありません。

最適化のための一般パラメータは、メインメニューから Optimization→ Parametersとた
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0 . 0 0 02 0 . 0 0 0 d e gd e g

図 6.7:接眼レンズの最適化前後の横収差比較

どると開くダイアログボックスを使って設定します。

6.1.6 一般情報を設定する (General Tab)

図 6.8:最適化のための一般パラメータを設定するダイアログボックス

ここでは、最適化プロセスの最多繰り返し回数と、最少繰り返し回数を設定できます。こ

こで繰り返しの最少回数を設定すれば、繰り返しサイクル毎の光学性能の改善率に関わら

ず、指定回数に達する前に最適化が終了することはありません。一方、最多繰り返し回数に

到達した場合には、最適化のプロセスは必ず終了します。また、サイクル毎の性能改善率が

あらかじめ設定した値 (IMPRコマンド)を下回る場合にも、最適化プロセスは終了します。

OpTaliX は、光学性能を評価するにあたり、入射瞳を矩形状の微小グリッドに分割した

うえで、各グリッドにつき１本の光線を追跡します。この考え方は最適化の場合も同様です。

しかし評価の際に用いられる “通常の” 瞳分割数 (NRDコマンド)とは異なる分割数の設定を、

最適化ために許しています。そのために設定される “最適化用の” 瞳分割数はNRDによって
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設定される評価用の瞳分割数を上回ることはできず、かつ最適化の間に限って有効です。

たとえば、NRD 32と設定し、最適化用のグリッドを 16x16と指定した場合には、最適

化が実行されている間のみ、評価用のグリッド (32x32)が１つおきに使われるということに

なります。その結果 OpTaliX にとっては光学性能を把握する能力が低下することと引き換

えに 32x32のグリッドを維持ままで設計する場合と比較して、光線追跡に要する時間が 1/4

まで短くなります。

最適化のアルゴリズムについては、現行の OpTaliX は 2種類のローカル最適化法を提供

しています。ひとつは LM(Levenberg-Marquardt)法です。もうひとつは KT(Kuhn-Tucker)法

です。特に指定のない限り、KT法がデフォルトの設定です。2つのアルゴリズムの詳細は、

リファレンスマニュアルの説明を参照してください。

Print detailed error function: このチェックボックスをクリックすると、メリット関数の値
とその構成要素が、最適化プロセスの開始直前と終了直後に出力されます。

Print detailed error function at each iteration: このチェックボックスをクリックすると、
メリット関数の値とその構成要素が、最適化の各サイクルごとに出力されます。このオプ

ションを設定すると多量の途中経過が出力されますから、ご注意ください。

6.1.7 LM法のためのパラメータを設定するタブ (Levenberg-Marquardt (LM) Tab)

図 6.9: LM 法による最適化のためのパラメータを設定するダイアログボックス

このタブから選択できるパラメータはただ一つ、最大ステップサイズです。デフォルトの

設定でほとんどの設計実務に対応できますから、通常は変更する必要がありません。設計プ

ロセスにおいて解の線形性が高く収束速度が遅いと判断される場合のみ、この値を小さめに

してください。一方、線形性が低くて解の安定性が悪い場合と判断される場合には逆に大き

くしてください。
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6.1.8 KT法のためのパラメータを設定するタブ (Kuhn-Tucker (KT) Tab)

図 6.10:LM 法による最適化のためのパラメータを設定するダイアログボックス

Show active constraints for each cycle:どの制約条件がアクティブになっているかを最適
化の繰り返しごとに出力します。不等式制約条件は、最適化の進行とともにアクティブに

なったり、解放されたりします。解放されるのは、その条件を考慮しなくとも自動的に解が

制約条件を満たすと OpTaliX が判断した場合のみです。

Show variables sensitivity:ここにチェックを入れると、メリット関数の変化に対する各変
数の相対的な寄与が出力されます。

Fractional improvement: 最多繰り返し回数の設定に関わらず、メリット関数の改善率が
ここに設定する水準を下回るとき、最適化は終了します。このチェックは最適化の各繰り返

しサイクル毎に実行されます。

6.1.9 デフォルトの制約条件を設定するタブ (Default Constraints Tab)

デフォルトの制約条件とは、最適化のプロセスにおいてレンズの寸法や空気間隔などが妥

当な値を維持するために自動的に付加される制約条件です。例えば、レンズのエッジ厚 (コ

バ厚)が常に製造可能な値 (レンズの直径に対する一定割合よりも厚いように) となるよう

に維持されますし、また、レンズどおしが物理的に干渉しない (軸上空気間隔ならびにエッ

ジ部の空気間隔がいずれも正の値をとる)ように考慮されます。この機能は “Enable default

constraints”にチェックした場合のみ有効になります。　
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図 6.11:デフォルトの制約条件を設定するダイアログボックス
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6.2 ズームレンズの最適化 (Zoom Lens Optimization)

ズーム光学系のレンズデータを設定する方法は、すでに 4.7(40ページ)章で説明しました。

それをふまえて、ここではズーム光学系の設計手順について説明します。ズーム光学系 (多重

構成系)は固定レンズの場合と比較すると、かなり多くの変数やコンストレイントを定義する

必要があります。初期データとして “Y=examplesY=optimizationY=zoom-lens 0.otx ”

を使用します。このデータは Laikinの著書「Lens Design第 3版」の例 35-1をベースに、そ

の性能を劣化させたものです。図 6.12にレンズ構成とズーム群の移動の様子を示します。

1
5

6 1 0 1 1 1 5

1 6

1 7 2 4 2 5

1
5

6 1 0

1 1

1 5

1 6

1 7 2 4 2 5

O A L  s 1 . . 1 6  =  9 9 . 5  

図 6.12:機械補正型 4群ズームレンズ。2つのポジション (Z1と Z3)における断面図。第 2

ポジション (Z2)の描画は省略しています。

このズームレンズは、4つのレンズ群 (1-5面,6-10面,11-15面,16-25面)から構成されてい

ます。図中の矢印で示されるように、外側のレンズ群は固定され、内側の 2つのレンズ群は

お互いに反対方向に移動します。このようにして、焦点距離は約 5.8mmから 58mmまで 10

倍変化します。

図 6.13に見られるように、初期データの結像性能はけして良くありません。説明の都合

上、わざと悪くしてあるからです。

まず設計変数を定義します。しかしそのためには全てのズームポジションに共通な変数と、

ポジション毎に値の異なる変数とを区別することから始めなくてはなりません。前者を “固
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定” 変数 (ズームの対象とならない設計変数)1、後者を “ズーム化” 変数 (ポジションごとに異

なった値を持つ設計変数)と呼びます。例えば曲率はどのポジションにおいても同じでなく

てはなりません (レンズ素子は共通に用いられるから）が、3カ所の空気間隔、すなわち THI

S5、THI S10、THI S15 はズーム化変数でなければなりません (そうでないと、“ズーム

レンズ” として機能しません)。

変数の定義はツールバーのアイコン をクリックするか、あるいはコマンドラインに

“VAR” と入力することにより開くダイアログから行います。開いたダイアログをみると (図

6.14参照)、タブで分類された２枚のシートのあることが分かります。それをクリックすると

チェックボックスがマトリクス状に配列しています。デフォルトでは左側のタブ、“Fixed”(固

定)タブが選択されています。こちらを選んだ状態で、“CUY”(曲率)欄の第 16面 (絞り)と 25

面 (像)を除いたすべてをチェックしてください。これで設計変数が定義されます。

次に “Zoom” タブをクリックしてします。すると、もう１枚のチェックボックスがマトリ

クス状に現れます。初期状態ではすべてのチェックボックスが空欄になっています。ここで

えは、ズームに対応して変化する面間隔 (第 5面、10面、15面に対する “THI”) をチェック

します。これでズーム化変数が定義されました。図 6.14は、以上の設定を完了した状態を示

しています。

繰り返しになりますが、“ズーム化パラメータ (ズーム化された設計変数)” と、“ズーム化

しないパラメータ (ズーム化されない設計変数)” を区別する必要がある事に注意してくださ

い。ズーム化された設計変数として指定されたパラメータは、ズームポジションの数だけの

自由度を持ちます (内部的にポジションの数だけ設計変数が増加しています）。

次に、メリット関数 (どのような制約のもとで、どの収差を最小化するか)を定義します。

まず、焦点距離を制約します。このレンズは 3つのズームポジションを定義してあるので、

各ポジションに個別に合計 3とおりの焦点距離を定義しなくてはなりません。そのための入

力は、(“Variables/Target” ダイアログの右半分のテキスト欄)に行います (もし、ダイアログ

ボックスを既に閉じてしまっていたら、var コマンドで再度、開きます)。図 6.15にならっ

て、焦点距離を間違えないように入力してください (たとえば、efl z1 = 5.9 の要領で)。

当然ながら、レンズの最適化の目的は、優れた結像性能を得ることにあります。それ故に、

性能の評価指標として、ここではスポットダイアグラムの RMS直径を使うことにします。

これを得るためのOpTaliX のコマンドは、(SPD)です。ダイアログボックスのテキスト入

力欄に、何行か追加しましょう。

spd f1..2 0 　　 画角 1から 2でのスポット径を 0と定義

spd f3 0 ; wt = 0.7 画角 3のスポット径は重みを 0.7と定義

spd に続く f1..2 や f3 は、画角を指定するための修飾子です。ここでは第 1画角と第

2画角に対するスポット径の目標値と、第 3画角に対するスポット径の目標値を個別に定義

し、その目標値はともにゼロとしました。しかし、第 3画角については目標値に対する重

み (重要度)を低く設定しています。(wt = 0.7 )。これは、視野周辺の性能を中心付近の性

能と比較していくらか劣化しても良いとしたためです。修飾子を指定する際はこの例のとお

り、1つ以上のスペースを空けて記述します。以上の入力により、制約条件と目標値の設定

1この呼び方は、語意としては矛盾しています。
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は図 6.16のようになります。

ここまでの設定により最適化を実行するできる状況となりました。しかし、このままでは、

まだ仕様を満たしているとはいえません。ズームレンズの場合に、一般にズームポジション

によらず焦点位置が維持される事と、両端のレンズ群が静止している事が求められます。前

者はバックフォーカス距離 (THI s24 )が変数に定義されていない事と、“PIM no ” の設定

になっている事から、自動的に達成されます。両端のレンズ群を固定するためには、第 1面

から最終面までの間隔を一定値に制約すればよいので、下記を設定します (ここでは全ての

移動群を含む第１面から絞り面までの総間隔を指定します)。

oal s1..16 = 99.5

この指定がレンズ断面図のどの部位に相当するかは、図 6.12に示してありますから参照し

てください。上記の制約条件にはズームポジションに対する修飾子が省略されています。こ

のような場合は、この制約が全てのポジションに対して同様に適用されます。

最後の制約条件は、移動するレンズ群間の空気間隔が負の値 (衝突してしまう)にならな

いように制御するための定義です。

thi s5 z1 > 1

thi s10 z3 > .1

thi s15 z1 > 1

以上の設定により、最終的な定義は図 6.17のようになります。

なお、固定焦点レンズの例のように、面間隔 (THI s24 )を変数に設定しつつ最適化する

こともできますが、この例題ではここまでとします。

ダイアログボックスを閉じたら、念のために、いま定義した設定を確認しておきましょう。

コマンド “LIS OPT” と入力するか、またはメニューから List→ Optimization→ All を選択

します。すると、以下のリストが表示されます。

Optimization setup : File = Zoom-Lens_0.OTX
Variables :

1 CUY
2 CUY
3 CUY
4 CUY
5 CUY
6 CUY
7 CUY
8 CUY
9 CUY

10 CUY
11 CUY
12 CUY
13 CUY
14 CUY
15 CUY
17 CUY
18 CUY
19 CUY
20 CUY
21 CUY
22 CUY
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23 CUY
24 CUY

Zoom Variables :
5 THI

10 THI
15 THI

Targets and constraints :
efl z1 = 5.9
efl z2 = 15
efl z3 = 59
spd f1..2 0
spd f3 0 ; wt = 0.7
oal s1..16 = 99.5
thi s5 z1 > 1
thi s10 z3 > .1
thi s15 z1 > 1

これで最適化を実行できます。コマンドラインで “OPT” と入力するか、またはメニュー

から Optimization→ Optimizeを選択します。最適化を実行すると、メリット関数の値は次

のとおり劇的に減少します。（この例では、LM 法に引続いてKT法で最適化されるよう、予

め設定されています。）

KT Optimization:
Number of Zoom variables : 9
Number of variables : 32
Number of functions : 2430
Number of equality constraints : 6
Number of inequality constraints : 3

Targets/Constraints Target Function Error
efl z1 = 5.9 5.900000 5.840701 -0.059299
efl z2 = 15 15.000000 14.760537 -0.239463
efl z3 = 59 59.000000 57.560921 -1.439079
spd f1..2 0 0.000000 0.016804 0.016804
spd f3 0 ; wt = 0.7 0.000000 0.026450 0.026450
oal s1..16 = 99.5 99.500000 98.805174 1.229824
thi s5 z1 > 1 1.000000 1.330000 0.330000
thi s10 z3 > .1 0.100000 0.100000 0.000000
thi s15 z1 > 1 1.000000 0.430000 -0.570000

Iter Min. Equal. Inequal. DumpingF. Improv.
0 0.660490 1.974295 0.754983 1.000000
1 0.235616 0.938567 0.574456 0.1000000E-01 0.64327
2 0.128306 0.041125 0.000000 0.1000000E-02 0.45545
3 0.096400 0.037822 0.000000 0.1000000E-03 0.24867
4 0.086081 0.021050 0.000000 0.3148169E-03 0.10705
5 0.083836 0.008540 0.000000 0.3148169E-03 0.02607
6 0.082402 0.008073 0.000000 0.3148169E-03 0.01711
7 0.081426 0.008142 0.000000 0.3148169E-03 0.01184
8 0.079383 0.008972 0.000000 0.3148169E-03 0.02510
9 0.078511 0.007531 0.053472 0.3148169E-03 0.01097

10 0.077906 0.007452 0.000000 0.3148169E-03 0.00771

Optimization stopped. Improvement is less than 0.01000 (1.00%)

Targets/Constraints Target Function Error
efl z1 = 5.9 5.900000 5.900001 0.000001
efl z2 = 15 15.000000 14.999983 -0.000017
efl z3 = 59 59.000000 58.999880 -0.000120
spd f1..2 0 0.000000 0.001808 0.001808
spd f3 0 ; wt = 0.7 0.000000 0.003582 0.003582
oal s1..16 = 99.5 99.500000 99.500000 0.000000
thi s5 z1 > 1 1.000000 1.000000 0.000000
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thi s10 z3 > .1 0.100000 0.100000 0.000000
thi s15 z1 > 1 1.000000 1.000000 0.000000

\

性能の改善 (収差の減少)は横収差図で確認できます (図 6.18)。この章で説明した内容に

関するいくらかの図が次ページ以降にありますから、参照してください。以上で、最適化

の例題を終了します。
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Wavelength

(micron)

0.45000

0.54600

0.65000

TRANSVERSE RAY ABERRATIONS File = Zoom-Lens_0.OTX 0.05000 mm

Pos 1

Pos 2

Pos 3

0.000
0.000 deg

deg0.000
0.000 deg

deg 0.000
15.000 deg

deg0.000
15.000 deg

deg 0.000
28.000 deg

deg0.000
28.000 deg

deg

0.000
0.000 deg

deg0.000
0.000 deg

deg 0.000
7.000 deg

deg0.000
7.000 deg

deg 0.000
12.000 deg

deg0.000
12.000 deg

deg

0.000
0.000 deg

deg0.000
0.000 deg

deg 0.000
1.500 deg

deg0.000
1.500 deg

deg 0.000
3.050 deg

deg0.000
3.050 deg

deg

TRANSVERSE RAY ABERRATIONS File = Zoom-Lens_0.OTX

0.05000 mm

Pos. 1 Pos. 2 Pos. 3

0.45000

0.54600

0.65000

        0.0000 deg
        0.0000 deg

        0.0000 deg
       15.0000 deg

        0.0000 deg
       28.0000 deg

        0.0000 deg
        0.0000 deg

        0.0000 deg
        7.0000 deg

        0.0000 deg
       12.0000 deg

        0.0000 deg
        0.0000 deg

        0.0000 deg
        1.5000 deg

        0.0000 deg
        3.0500 deg

図 6.13:初期レンズデータ (最適化前)の横収差図。　注）上記はいずれも同じ内容を示して

います。違いは長軸 (開口に相当)が鉛直線として表現されているか、あるいは水平線とし

て表現されているかだけです。どちらを選択するかは、好みによります。File→ Preferences

より ‘operations’タブを選択し、‘Align ray fan curves horizontally’にチェックを入れるか外せ

ば、切り替えられます。
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図 6.14:変数の編集 (左：固定パラメータ/右：ズームパラメータ)

図 6.15:3つのズームポジションに対する焦点距離の定義
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図 6.16:スポット径を最小化する定義を追加

図 6.17:制約/目標の定義 (最終)
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TRANSVERSE RAY ABERRATIONS File = Zoom-Lens_0.OTX

0.05000 mm

Pos. 1 Pos. 2 Pos. 3

0.45000

0.54600

0.65000

        0.0000 deg
        0.0000 deg

        0.0000 deg
       15.0000 deg

        0.0000 deg
       28.0000 deg

        0.0000 deg
        0.0000 deg

        0.0000 deg
        7.0000 deg

        0.0000 deg
       12.0000 deg

        0.0000 deg
        0.0000 deg

        0.0000 deg
        1.5000 deg

        0.0000 deg
        3.0500 deg

図 6.18:最適化終了後の横収差図：最適化前の横収差 (図 6.13と比較してください)。

OpTaliX Tutorial



67

第7章 コーティング – Coatings –

コーティングに関する例題は、次バージョン以降のチュートリアルに記載されます。チュー

トリアルの改訂版は、ウェブサイト http://www.optenso.de/　または http://www.ekklesia.co.jp/

のダウンロードページからダウンロードできます

コーティングに関する詳細は、リファレンスマニュアルを参照してください。
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このページは白紙です。
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